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Introduction

This example models a solid oxide electrolyzer cell wherein water vapor is reduced to form
hydrogen gas on the cathode, and oxygen gas is evolved on the anode. The current
distribution in the cell is coupled to the cathode mass transfer of hydrogen and water and
momentum transport.

Model Definition

On the anode, oxygen ions are oxidized to form oxygen gas,
207 & Oy(g) +4e’ (1
whereas on the cathode, water vapor is reduced to form hydrogen gas and oxygen ions:
2H,0(g) + 4 > 2Hy(g)+20° )

Figure 1 shows the model geometry. Since the oxygen is the only gas present in the anode
gas chamber, and isobaric conditions are assumed, there is no need to explicitly model the

anode gas transport. Four computational domains are hence used in the model: the
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cathode gas channels, the cathode gas diffusion electrode, the solid oxide electrolyte layer,

and the anode gas diffusion electrode.

Inlet

Outlet

Figure 1: Model geometry. From top: Cathode gas channels, cathode gas diffusion electrode,
solid oxide electrolyte layer, and anode gas diffusion layer. The positions of the inlet and outlet
are indicated in the figure.

The composition of the hydrogen-water vapor mixture will change as a result of the
electrochemical reactions. The mass transport of hydrogen and water vapor is modeled in
the cathode gas channels and the gas diffusion electrode, coupled to the resulting
(laminar) flow of the gas mixture.

The current distribution is defined assuming a constant conductivity of the solid
electrolyte. The Water Electrolyzer interface is used to define the electrode reactions and
the electrolyte charge transport in the porous gas diffusion electrodes and the electrolyte
layer, as well as the mass transport of hydrogen and water. The momentum flow is defined
in the model using the Free and Porous Media Flow interface. Brinkman equations are
used for the porous gas diffusion electrodes and Navier-Stokes equations are used for the

nonporous gas channels.

On the cathode side, the electrode kinetics depends on the local concentration of water
and hydrogen according to the law of mass action (and Nernst equation). On the anode
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side, and a uniform partial pressure of oxygen is assumed and a concentration-independent

Butler-Volmer expression is hence used to define the electrode kinetics.

The properties of the cathode gas mixture, as well as the equilibrium potentials of the
electrode reactions are automatically defined by the default built-in options of the Water
Electrolyzer interface.

Results and Discussion

Figure 2 shows the velocity magnitude distribution in the cell. The highest velocities are

located close to the inlet and outlet.

Slice: Velocity magnitude (m/s) Streamline: Velocity field

3.5

115

0.5

Figure 2: Velocity in the cell.
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Figure 3 shows how the density and the dynamic viscosity of the gas relate to the hydrogen
and water molar fractions shown in Figure 4. As the hydrogen content of the gas increases
toward the outlet, the density and the viscosity both decrease.

Surface: Density (kg/m’) Surface: Dynamic viscosity (Pa*s)

Figure 3: Density (left) and dynamic viscosity (vight).

Species H2: Mole fraction (1) Species H20: Mole fraction (1)
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Figure 4: Hydrogen (left) and water vapor (vight) molar fractions.
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Figure 5 shows the molar fraction of hydrogen in the gas mixture, and the corresponding
hydrogen flux streamlines. The molar fraction is close to zero at the inlet and almost 100%
at the outlet.

Streamline: Total flux Volume: Mole fraction (1)

Figure 5: Hydrogen molar fraction (slice) and flux (streamlines).

Finally, Figure 6 shows the cross-sectional electrolyte current density in the middle of the
electrolyte between the anode and the cathode. The current density is highest close to the

inlet, where the water,/hydrogen ratio is high, and decreases toward the outlet.
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Slice: Electrolyte current density vector, z component (A/m?)

x10*

-

Figure 6: Electrolyte current density through electrolyte layer.

Application Library path: Fuel_Cell_and_Electrolyzer_Module/Electrolyzers/
soec

Modeling Instructions

This tutorial models the current distribution in a solid oxide electrolyzer. The tutorial
comprises two major parts. First, a secondary (not concentration dependent) current
distribution is modeled. In the second part, mass and momentum transport are added to
model a concentration-dependent current distribution of the cell, where the mixture

properties of the anode gas depends on the molar fractions of water and hydrogen.

From the File menu, choose New.

NEW
In the New window, click Model Wizard.
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MODEL WIZARD

I In the Model Wizard window, click [l 3D.

2 In the Select Physics tree, select Electrochemistry>Water Electrolyzers>Solid Oxide (we).
3 Click Add.

4 Click e Study.

5 In the Select Study tree, sclect Preset Studies for Selected Physics Interfaces>

Stationary with Initialization.

6 Click [/ Done.

GEOMETRY |

The model geometry is available as a parameterized geometry sequence in a separate
MPH-file. If you want to build it from scratch, follow the instructions in the section
Appendix - Geometry Modeling Instructions. Otherwise load it from file using the

following steps.

I In the Geometry toolbar, click Insert Sequence.

2 Browse to the model’s Application Libraries folder and double-click the file
soec_geom_sequence.mph.

3 In the Geometry toolbar, click [E2 Build All.
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GLOBAL DEFINITIONS

Geometry Parameters

I In the Model Builder window, under Global Definitions click Parameters I.
2 In the Settings window for Parameters, typc Geometry Parameters in the Label text
field.

Physics Parameters

Some parameters were imported with the geometry sequence. Import some additional
physics parameters from a text file.

I In the Home toolbar, click Pi Parameters and choose Add>Parameters.

2 In the Settings window for Parameters, type Physics Parameters in the Label text
field.

3 Locate the Parameters section. Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file
soec_physics_parameters.txt.

WATER ELECTROLYZER (WE)

Now define the current distribution in the gas diffusion electrodes and the electrolyte.

I In the Model Builder window, under Component | (compl) click Water Electrolyzer (we).

2 In the Settings window for Water Electrolyzer, locate the Domain Selection section.

3 Click IL:G Clear Selection.

4 Seclect Domains 1-3 only.

5 Locate the H2 Gas Mixture section. Find the Transport mechanisms subsection. Clear the
Include gas phase diffusion check box.

Membrane |

I In the Physics toolbar, click {&8 Domains and choose Membrane.

2 Select Domain 2 only.

Electrolyte Phase |

Set up the electrolyte conductivity in the Electrolyte Phase node.

I In the Model Builder window, click Electrolyte Phase I.

2 In the Settings window for Electrolyte Phase, locate the Electrolyte Charge Transport
section.

3 In the oy text field, type sigma_L1.
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H2 Gas Diffusion Electrode |

Set up the properties of the H2 Gas Diffusion Electrode node. The details of electrode
kinetics are set in the child node. Note that the reference equilibrium potential is
calculated automatically when the default Built in option is used.

I In the Physics toolbar, click {#8 Domains and choose H2 Gas Diffusion Electrode.

2 In the Settings window for H2 Gas Diffusion Electrode, locate the Domain Selection

section.
3 From the Selection list, choose Cathode.
4 Locate the Electrode Charge Transport section. In the o4 text field, type sigmaeff_s.
5 Locate the Effective Electrolyte Charge Transport section. In the g text field, type por_L1.
H2 Gas Diffusion Electrode Reaction |

I In the Model Builder window, expand the H2 Gas Diffusion Electrode |1 node, then click

H2 Gas Diffusion Electrode Reaction |.

2 In the Settings window for H2 Gas Diffusion Electrode Reaction, locate the

Electrode Kinetics section.
3 In the i (7T text field, type 10_H2.
4 Locate the Active Specific Surface Area section. In the a, text field, type S.
02 Gas Diffusion Electrode |
Similarly, set up the properties of the 02 Gas Diffusion Electrode node. The details of
electrode kinetics are set in the child node. Note that the reference equilibrium potential
is calculated automatically when the default Built in option is used.
I In the Physics toolbar, click {8 Demains and choose 02 Gas Diffusion Electrode.

2 In the Settings window for 02 Gas Diffusion Electrode, locate the Domain Selection

section.
3 From the Selection list, choose Anode.
4 Locate the Electrode Charge Transport section. In the o4 text field, type sigmaeff_s.
5 Locate the Effective Electrolyte Charge Transport scction. In the g text field, type por_1.
02 Gas Diffusion Electrode Reaction |

I In the Model Builder window, expand the 02 Gas Diffusion Electrode | node, then click
02 Gas Diffusion Electrode Reaction I.

2 In the Settings window for 02 Gas Diffusion Electrode Reaction, locate the

Electrode Kinetics section.

3 In the i (7T text field, type 10_02.
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4 In the o, text field, type 3.5.
5 Locate the Active Specific Surface Area section. In the a, text field, type S.

Electronic Conducting Phase |
Finally, set up the boundary conditions.

I In the Model Builder window, click Electronic Conducting Phase I.

Electric Ground |

I In the Physics toolbar, click |=° Attributes and choose Electric Ground.

2 In the Settings window for Electric Ground, locate the Boundary Selection section.
3 From the Selection list, choose Cathode Current Collector.

Electronic Conducting Phase |
In the Model Builder window, click Electronic Conducting Phase 1.

Electrode Current |

I In the Physics toolbar, click |=° Attributes and choose Electrode Current.

2 In the Settings window for Electrode Current, locate the Electrode Current section.
3 From the list, choose Average current density.

4 Locate the Boundary Selection scction. From the Selection list, choose

Anode Current Collector.

5 Locate the Electrode Current section. In the ig gyerage text field, type I_avg.

GLOBAL DEFINITIONS

Default Model Inputs

Default Model Inputs node can be used to set the Temperature for the entire model. This
node may be accessed by multiple physics nodes.

I In the Model Builder window, under Global Definitions click Default Model Inputs.

2 In the Settings window for Default Model Inputs, locate the Browse Model Inputs section.
3 In the tree, select General>Temperature (K) - minput.T.

4 Find the Expression for remaining selection subsection. In the Temperature text field, type
T.

MESH |

The physics settings for the first part of the tutorial are now complete. Add a user-defined
mesh.
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Size |
I In the Model Builder window, under Component | (compl) right-click Mesh I and choose

Size.
2 In the Settings window for Size, click to expand the Element Size Parameters section.
3 Locate the Element Size section. Click the Custom button.
4 Locate the Element Size Parameters section. Select the Maximum element size check box.
5 In the associated text field, type H_ch*0.8.
Swept |
I In the Mesh toolbar, click 42 Swept.
2 In the Settings window for Swept, locate the Domain Selection section.
3 From the Geometric entity level list, choose Domain.
4 Select Domains 5-7 only.
5 Click ] Build Selected.

Boundary Layers |
Also add boundary layer mesh nodes at this stage. These are actually not needed for the
first calculation, but will improve the accuracy and convergence of the solution for the

second part of the tutorial when mass transport and convection has been added.
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I In the Mesh toolbar, click [ Boundary Layers.

2 In the Settings window for Boundary Layers, locate the Geometric Entity Selection section.
3 From the Geometric entity level list, choose Domain.

4 Select Domains 5-7 only.

Boundary Layer Properties

I In the Model Builder window, click Boundary Layer Properties.

2 In the Settings window for Boundary Layer Properties, locate the Boundary Selection

section.
3 Click % Paste Selection.

4 In the Paste Selection dialog box, type 21-23, 25, 28-30, 32, 35-37, 39in the
Selection text field.

5 Click OK.

6 In the Settings window for Boundary Layer Properties, locate the

Boundary Layer Properties section.
7 In the Number of boundary layers text field, type 2.
8 In the Boundary layer stretching factor text field, type 1.3.
9 From the Thickness of first layer list, choose Manual.
10 In the Thickness text field, type H_ch/10.
Il Click | Build Selected.
Free Tetrahedral | i
I In the Mesh toolbar, click €5}, Free Tetrahedral.
2 In the Settings window for Free Tetrahedral, locate the Domain Selection section.
3 From the Geometric entity level list, choose Domain.

4 Seclect Domains 4 and 8 only.
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5 Click ™ Build Selected.

Boundary Layers 2
I In the Model Builder window, under Component | (compl)>Mesh | right-click

Boundary Layers | and choose Duplicate.
2 In the Settings window for Boundary Layers, locate the Geometric Entity Selection section.
3 Click IL:G Clear Selection.
4 Seclect Domains 4 and 8 only.
Boundary Layer Properties

I In the Model Builder window, expand the Boundary Layers 2 node, then click
Boundary Layer Properties.

2 In the Settings window for Boundary Layer Properties, locate the Boundary Selection

section.
3 Click IL_—_I] Clear Selection.
4 Click F‘D Paste Selection.

5 In the Paste Selection dialog box, type 14-18, 24, 31, 38, 41, 43-45, 47, 49,
51, 52 in the Selection text field.

6 Click OK.
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Boundary Layers 2

In the Model Builder window, right-click Boundary Layers 2 and choose Build Selected.

Free Triangular |

I In the Mesh toolbar, click A Boundary and choose Free Triangular.

2 In the Settings window for Free Triangular, locate the Boundary Selection section.

3 From the Selection list, choose Cathode Current Collector.

Build Selected.

4 Click ®

Swept 2

Swept.

e
L
Fire

In the Mesh toolbar, click 4%

Distribution |

I Right-click Swept 2 and choose Distribution.

2 In the Settings window for Distribution, locate the Domain Selection section.

-

on.

Clear Select

-

va.—|

L

3 Click

4 Sclect Domain 3 only.

5 Locate the Distribution scction. From the Distribution type list, choose Predefined.

6 In the Element ratio text field, type 2.

7 Select the Reverse direction check box.

SOLID OXIDE ELECTROLYZER
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Distribution 2

I In the Model Builder window, right-click Swept 2 and choose Distribution.

2 In the Settings window for Distribution, locate the Domain Selection section.

-

on.

Clear Select

-

ﬁj

L

3 Click

4 Seclect Domain 2 only.

5 Locate the Distribution section. In the Number of elements text field, type 2.

Distribution 3

I In the Model Builder window, under Component | (compl)>Mesh 1>Swept 2 right-click

Distribution | and choose Duplicate.

tion.

2 In the Settings window for Distribution, locate the Domain Selection sec

-

Y

on.

Clear Select:

-

3 Click

L

4 Seclect Domain 1 only.

ion section. Clear the Reverse direction check box.

but
Id All.

Distri

5 Locate the

6 Click 25 Bu

STUDY

The problem is now ready for solving.
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I In the Home toolbar, click = Compute.

RESULTS

Electrode Potential with Respect to Ground (we)
I In the Electrode Potential with Respect to Ground (we) toolbar, click Plot.

Inspect the potential plot. The plot should look as follows:

Multislice: Electric potential (V) Arrow Volume: Electrode current density vector

14

12
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COMPONENT I (COMPI)

Now start with the second part of the tutorial which adds a Free and Porous Media Flow
interface to the cathode side of the model, enables hydrogen gas phase diffusion in the
Water Electrolyzer interface, and couples the distribution of hydrogen and water vapor to

the electrochemistry.

ADD PHYSICS
I In the Home toolbar, click i Add Physics to open the Add Physics window.

2 Go to the Add Physics window.

3 In the tree, select Fluid Flow>Porous Media and Subsurface Flow>
Free and Porous Media Flow (fp).

4 Click Add to Component | in the window toolbar.
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5

In the Home toolbar, click i Add Physics to close the Add Physics window.

FREE AND POROUS MEDIA FLOW (FP)

|
2

0 N o0 U1 AW

Select Domains 3-8 only.

In the Settings window for Free and Porous Media Flow, locate the Domain Selection

section.

Click "§ Create Selection.

In the Create Selection dialog box, type Gas domains in the Selection name text field.
Click OK.

In the Settings window for Free and Porous Media Flow, locate the Physical Model section.
From the Compressibility list, choose Compressible flow (Ma<0.3).

In the Model Builder window, click Free and Porous Media Flow (fp).

Fluid and Matrix Properties |

|
2

5

In the Physics toolbar, click @ Domains and choose Fluid and Matrix Properties.

In the Settings window for Fluid and Matrix Properties, locate the Domain Selection

section.
From the Selection list, choose Cathode.

Locate the Porous Matrix Properties scction. From the g, list, choose User defined. In the
associated text field, type por.

From the « list, choose User defined. In the associated text field, type kappa.

Inlet |

|
2
3
4
5

In the Physics toolbar, click mw Boundaries and choose Inlet.

In the Settings window for Inlet, locate the Boundary Selection scction.
From the Selection list, choose Inlet.

Locate the Boundary Condition section. From the list, choose Mass flow.

Locate the Mass Flow section. In the m text field, type MfLux_in.

Outlet |

|
2
3
4

In the Physics toolbar, click mw Boundaries and choose Outlet.
In the Settings window for Outlet, locate the Boundary Selection scction.
From the Selection list, choose Outlet.

Locate the Pressure Conditions section. Select the Normal flow check box.
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MULTIPHYSICS

Reacting Flow, H2 Gas Phase | (rfhl)
In the Physics toolbar, click ﬁ{'{:}] Multiphysics Couplings and choose Domain>Reacting Flow,
H2 Gas Phase.

WATER ELECTROLYZER (WE)

I In the Model Builder window, under Component | (compl) click Water Electrolyzer (we).

2 In the Settings window for Water Electrolyzer, locate the Domain Selection section.

3 From the Selection list, choose All domains.

4 Locate the H2 Gas Mixture section. Find the Transport mechanisms subsection. Select the
Include gas phase diffusion check box.

H2 Flow Channel |

I In the Physics toolbar, click {8 Domains and choose H2 Flow Channel.

2 In the Settings window for H2 Flow Channel, locate the Domain Selection section.

3 From the Selection list, choose Channel Domains.

H2 Gas Diffusion Electrode |

I In the Model Builder window, click H2 Gas Diffusion Electrode I.

2 In the Settings window for H2 Gas Diffusion Electrode, locate the Gas Transport section.

3 In the &g text field, type por.

H2 Gas Phase |

Note that the settings on the H2 Gas Phase node are either the default option or

automatically set by the multiphysics coupling node. Set up the required boundary
conditions and initial values.

I In the Model Builder window, click H2 Gas Phase I.

H2 Inlet |

I In the Physics toolbar, click |=° Attributes and choose H2 Inlet.

2 In the Settings window for H2 Inlet, locate the Boundary Selection section.

3 From the Selection list, choose Inlet.

4 Locate the Mixture Specification section. From the list, choose Mass flow rates.
5 In the J oo text field, type Mflux_in.

H2 Gas Phase |
In the Model Builder window, click H2 Gas Phase 1.
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H2 Outlet |
I In the Physics toolbar, click |=° Attributes and choose H2 Outlet.

2 In the Settings window for H2 Outlet, locate the Boundary Selection section.

3 From the Selection list, choose Outlet.

Initial Values |

I In the Model Builder window, click Initial Values I.
2 In the Settings window for Initial Values, locate the Initial Values section.

3 In the xq goo text field, type 0.95* (1-x/(W_cell*stoich)).

STUDY |

The concentration-dependent model is now ready for solving. Use a sequence of study
steps, solving first for the current distribution initialization, then the flow, and finally the
fully coupled problem. By solving for only one set of physics at a time in individual steps,
suitable initial values automatically propagate to the final study step where the complete
problem is solved.

Step I: Current Distribution Initialization
I In the Model Builder window, under Study 1 click

Step I: Current Distribution Initialization.

2 In the Settings window for Current Distribution Initialization, locate the

Physics and Variables Selection section.
3 In the table, clear the Solve for check box for Free and Porous Media Flow (fp).
4 In the table, clear the Solve for check box for Reacting Flow, H2 Gas Phase | (rfhl).
Step 2: Stationary
I In the Model Builder window, click Step 2: Stationary.
2 In the Settings window for Stationary, locate the Physics and Variables Selection section.
3 In the table, clear the Solve for check box for Water Electrolyzer (we).
4 In the table, clear the Solve for check box for Reacting Flow, H2 Gas Phase | (rfhl).
Stationary 2
I In the Study toolbar, click E Study Steps and choose Stationary>Stationary.
Remove the old study sequence and generate a new one.
Solver Configurations

In the Model Builder window, under Study | right-click Solver Configurations and choose

Delete Configurations.
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Solution [ (soll)

In the Study toolbar, click ""s. Show Default Solver.

2 In the Model Builder window, expand the Solution 1 (soll) node.
3 In the Model Builder window, expand the Study 1>Solver Configurations>
Solution 1 (soll)>Stationary Solver 3 node.
4 Right-click Stationary Solver 3 and choose Fully Coupled.
5 In the Study toolbar, click = Compute.
The problem should solve in about two minutes.
RESULTS
Start the postprocessing of the solution by inspecting and polishing the default plot for the
velocity field.
Slice

2
3
4
5
6

In the Model Builder window, expand the Results>Velocity (fp) node, then click Slice.
In the Settings window for Slice, locate the Plane Data section.

From the Plane list, choose xy-planes.

From the Entry method list, choose Coordinates.

In the z-coordinates text field, type H_cell-H_ch/2.

In the Velocity (fp) toolbar, click Plot.

Streamline |

|
2

In the Model Builder window, right-click Velocity (fp) and choose Streamline.

In the Settings window for Streamline, click Replace Expression in the upper-right corner
of the Expression section. From the menu, choose Component | (compl)>

Free and Porous Media Flow>Velocity and pressure>u,v,w - Velocity field.
Locate the Selection section. From the Selection list, choose Inlet.

Locate the Coloring and Style section. Find the Point style subsection. From the Type list,

choose Arrow.
From the Arrow distribution list, choose Equal inverse time.

From the Color list, choose Black.
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7 In the Velocity (fp) toolbar, click Plot.

Slice: Velocity magnitude (m/s) Streamline: Velocity field

3.5

115

Density

The density of the gas mixture will change as water is replaced by hydrogen in the gas
stream. Plot the density as follows:

I In the Home toolbar, click @1 Add Plot Group and choose 3D Plot Group.

2 In the Settings window for 3D Plot Group, type Density in the Label text field.
Surface |

I Right-click Density and choose Surface.

2 In the Settings window for Surface, click Replace Expression in the upper-right corner of
the Expression scction. From the menu, choose Component | (compl)>

Free and Porous Media Flow>Material properties>fp.rho - Density - kg/m?®.
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3 In the Density toolbar, click Plot.

Surface: Density (kg/m’)

Viscocity

Also the viscocity will change in the gas stream.

I In the Home toolbar, click @1 Add Plot Group and choose 3D Plot Group.

2 In the Settings window for 3D Plot Group, type Viscocity in the Label text field.
Surface |

I Right-click Viscocity and choose Surface.

2 In the Settings window for Surface, click Replace Expression in the upper-right corner of
the Expression section. From the menu, choose Component | (compl)>

Free and Porous Media Flow>Material properties>fp.mu - Dynamic viscosity - Pa‘s.

3 In the Viscocity toolbar, click Plot.

Surface: Dynamic viscosity (Pa*s)
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Mole Fraction, H2, Surface (we)
Default plots are created for the hydrogen and water molar fractions.

Species H2: Mole fraction (1)

0%
0.4
0.3
0.2
0.1
Mole Fraction, H20, Surface (we)
Species H20: Mole fraction (1)
0.9
0.8
0.7
0.6
0%

0.4
0.3
0.2
0.1

Molar Fraction and Flux, H2
Create a plot for the hydrogen molar fraction and flux as follows:
I In the Home toolbar, click @1 Add Plot Group and choose 3D Plot Group.

2 In the Settings window for 3D Plot Group, type Molar Fraction and Flux, H2in the
Label text field.

3 Locate the Plot Settings scction. Clear the Plot dataset edges check box.
Streamline |
I Right-click Molar Fraction and Flux, H2 and choose Streamline.

2 In the Settings window for Streamline, click Replace Expression in the upper-right corner
of the Expression section. From the menu, choose Component | (compl)>
Water Electrolyzer>Species H2>we.tfluxH2x,...,we.tfluxH2z - Total flux.

3 Locate the Streamline Positioning scction. In the Number text field, type 30.

4 Locate the Selection section. From the Selection list, choosc Outlet.
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5 Locate the Coloring and Style section. Find the Point style subsection. From the Type list,
choose Arrow.

6 From the Arrow distribution list, choose Equal inverse time.

7 From the Color list, choose Black.

Selection |

I Right-click Streamline | and choose Selection.

2 In the Settings window for Selection, locate the Selection section.

3 From the Selection list, choose Channel Domains.

Volume |

I In the Model Builder window, right-click Molar Fraction and Flux, H2 and choose Volume.

2 In the Settings window for Volume, click Replace Expression in the upper-right corner of
the Expression section. From the menu, choose Component | (compl)>

Water Electrolyzer>Species H2>we.xH2 - Mole fraction.
Selection |
I Right-click Volume I and choose Selection.
2 In the Settings window for Selection, locate the Selection section.
3 From the Selection list, choose Cathode.

4 Click the Show Grid button in the Graphics toolbar.
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5 In the Molar Fraction and Flux, H2 toolbar, click Plot.

Streamline: Total flux Volume: Mole fraction (1)

Cross-Sectional Electrolyte Current Density
Finally, plot the current distribution across the electrolyte layer as follows:
I In the Home toolbar, click @1 Add Plot Group and choose 3D Plot Group.

2 In the Settings window for 3D Plet Group, type Cross-Sectional Electrolyte
Current Density in the Label text field.

3 Locate the Plot Settings section. Clear the Plot dataset edges check box.
Slice |
I Right-click Cross-Sectional Electrolyte Current Density and choose Slice.

2 In the Settings window for Slice, click Replace Expression in the upper-right corner of the
Expression section. From the menu, choose Component | (compl)>Water Electrolyzer>
Electrolyte current density vector - Al/m*>we.llz - Electrolyte current density vector,

z component.
3 Locate the Plane Data section. From the Plane list, choose xy-planes.
4 From the Entry method list, choose Coordinates.

5 In the z-coordinates text field, type H_gde+H_el/2.
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6 In the Cross-Sectional Electrolyte Current Density toolbar, click Plot.

Slice: Electrolyte current density vector, z component (A/m?)

x10*

-

Appendix - Geometry Modeling Instructions

From the File menu, choose New.

NEW
In the New window, click Model Wizard.

MODEL WIZARD
I In the Model Wizard window, click 3D.

2 Click E,/ Done.

GLOBAL DEFINITIONS
Geometry Parameters
I In the Model Builder window, under Global Definitions click Parameters 1.

2 In the Settings window for Parameters, type Geometry Parameters in the Label text
field.

3 Locate the Parameters section. Click =~ Load from File.
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4 Browse to the model’s Application Libraries folder and double-click the file
soec_geom_parameters.txt.

GEOMETRY |

Anode
I In the Geometry toolbar, click |_'__'_|__'_':| Block.

In the Settings window for Block, type Anode in the Label text field.
Locate the Size and Shape section. In the Width text field, type W_cell.

2
3
4 In the Depth text field, type D_cell.
5 In the Height text field, type H_gde.
6

Locate the Selections of Resulting Entities section. Select the Resulting objects selection

check box.
Electrolyte
I Right-click Anode and choose Duplicate.
2 In the Settings window for Block, type Electrolyte in the Label text field.
3 Locate the Pesition section. In the z text field, type H_gde.
Cathode
I Right-click Electrolyte and choose Duplicate.
2 In the Settings window for Block, type Cathode in the Label text field.
3 Locate the Position section. In the z text field, type H_gde+H_el.
Work Plane | (wpl)
I In the Geometry toolbar, click % Work Plane.
2 In the Settings window for Work Plane, locate the Plane Definition section.
3 In the z-coordinate text field, type H_cell-H_ch.

Work Plane | (wpl)>Plane Geometry
In the Model Builder window, click Plane Geometry.

Work Plane | (wpl)>Rectangle | (rl)

I In the Work Plane toolbar, click |:| Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.
3 In the Width text field, type W_ch.

4 In the Height text field, type N_ch* (W_ch+W_rib).

5 Locate the Pesition section. In the xw text field, type W_rib/2.
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6 In the yw text field, type W_rib/2.

Work Plane | (wpl)>Rectangle 2 (r2)
I Right-click Component | (compl)>Geometry 1>Work Plane | (wpl)>Plane Geometry>
Rectangle | (r1) and choose Duplicate.

2 In the Settings window for Rectangle, locate the Position section.

3 In the xw text field, type W_rib/2+L_ch+W_ch.

4 In the yw text field, type -W_rib/2.

Work Plane | (wpl)>Rectangle 3 (r3)

I In the Work Plane toolbar, click |:| Rectangle.
In the Settings window for Rectangle, locate the Size and Shape section.
In the Width text field, type L_ch.

2

3

4 In the Height text field, type W_ch.

5 Locate the Position section. In the xw text field, type W_rib/2+W_ch.
6

In the yw text field, type W_rib/2.

Work Plane | (wpl)>Array | (arrl)

I In the Work Plane toolbar, click /), Transforms and choose Array.
Select the object r3 only.
In the Settings window for Array, locate the Size section.

2

3

4 In the yw size text field, type N_ch.

5 Locate the Displacement section. In the yw text field, type W_ch+W_rib.
6

In the Work Plane toolbar, click [EE Build All.
Channel Domains
I In the Model Builder window, right-click Geometry | and choose Extrude.
2 In the Settings window for Extrude, type Channel Domains in the Label text field.

3 Locate the Distances section. In the table, enter the following settings:

Distances (m)

H_ch

4 Locate the Selections of Resulting Entities section. Select the Resulting objects selection
check box.

Form Union (fin)
In the Model Builder window, right-click Form Union (fin) and choose Build Selected.
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Inlet

I In the Geometry toolbar, click T Selections and choose Explicit Selection.
2 In the Settings window for Explicit Selection, type Inlet in the Label text field.

3 Locate the Entities to Select section. From the Geometric entity level list, choose

Boundary.
4 On the object fin, select Boundary 19 only.
Outlet
I In the Geometry toolbar, click T Selections and choose Explicit Selection.
2 In the Settings window for Explicit Selection, type Outlet in the Label text ficld.

3 Locate the Entities to Select section. From the Geometric entity level list, choose

Boundary.
4 On the object fin, select Boundary 42 only.
Cathode Current Collector
I In the Geometry toolbar, click T Selections and choose Explicit Selection.

2 In the Settings window for Explicit Selection, type Cathode Current Collector in the
Label text field.

3 Locate the Entities to Select section. From the Geometric entity level list, choose

Boundary.
4 On the object fin, select Boundaries 10, 26, 33, and 40 only.
Anode Current Collector
I In the Geometry toolbar, click T Selections and choose Explicit Selection.

2 In the Settings window for Explicit Selection, type Anode Current Collector in the
Label text field.

3 Locate the Entities to Select section. From the Geometric entity level list, choose

Boundary.

4 On the object fin, select Boundary 3 only.
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